Migrating Monarch Classic Files to Data Prep Studio and Monarch Swarm
Datawatch Corporation makes no representation or warranties with respect to the contents of this manual or the associated software and especially disclaims any implied warranties of merchantability or fitness for any particular purpose. Further, Datawatch Corporation reserves the right to revise this publication and make changes from time to time to its contents without obligation to notify anyone of such revisions or changes.

Datawatch Monarch Complete and Monarch Swarm software are offered and is to be used in accordance with a SOFTWARE LICENSE AND MAINTENANCE AGREEMENT. This agreement stipulates that this software be used only in the computer system designated in that agreement. The agreement further stipulates that the customer shall not copy or alter, or permit others to copy or alter, the software or related materials in whole or in part, in any media for any purpose, except to make an archive (back-up) copy or to make a copy as an essential step in the use of the software with the customer’s computer.

Datawatch Corporation hereby grants the buyer the right to reprint this documentation for internal uses only. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, for any other purposes, without the prior written permission of Datawatch Corporation.

Migrating Monarch Classic Files to Data Prep Studio and Monarch Swarm
Copyright © 2018 by Datawatch Corporation
All rights reserved. Printed in the U.S.A.
Unpublished - Rights reserved under the copyright law of the United States.

Datawatch Monarch Complete and Monarch Swarm are trademarks of Datawatch Corporation. Other products mentioned herein may be trademarks or registered trademarks of their respective owners in the United States or other countries.

For U.S. Government End Users, the software is a "Commercial Item(s),” as that term is defined at 48 C.F.R. Section 2.101, consisting of “Commercial Computer Software” and “Commercial Computer Software Documentation,” as such terms are used in 48 C.F.R. Section 12.212 or 48 C.F.R. Section 227.7202, as applicable. Consistent with 48 C.F.R. Section 12.212 or 48 C.F.R. Sections 227.7202-1 through 227.7202-4, as applicable, the Commercial Computer Software and Commercial Computer Software Documentation are being licensed to U.S. Government end users (a) only as Commercial Items and (b) with only those rights as are granted to all other end users pursuant to the Datawatch Software License and Maintenance Agreement.
# Table of Contents

**Introduction** .................................................................................................................. 1

Assumptions ............................................................................................................................. 2

**Working with Monarch Classic Files in Data Prep Studio** ................................................. 3

Accepting Inputs ..................................................................................................................... 3
  - Projects ............................................................................................................................... 3
  - Models ................................................................................................................................. 3
  - Report Files ......................................................................................................................... 4

Known Limitations ................................................................................................................... 4

Loading Classic Models in Data Prep Studio ......................................................................... 5
  - Drag and Drop ................................................................................................................... 5
  - The Open Data Dialog ...................................................................................................... 5

Loading Classic Reports in Data Prep Studio ....................................................................... 7

Further Reading ..................................................................................................................... 10

**Working with Monarch Classic Files in Monarch Swarm** .............................................. 11

Accepting Inputs ..................................................................................................................... 11
  - Models ............................................................................................................................... 11
  - Projects ............................................................................................................................... 11
  - Report Files ....................................................................................................................... 11

Known Limitations ................................................................................................................ 12

Uploading Classic Models to Monarch Swarm ..................................................................... 12

Uploading Classic Report Files to Monarch Swarm ............................................................. 15
  - Drag and Drop ................................................................................................................ 15
  - Upload a File via the + New Command ........................................................................... 19

Further Reading ................................................................................................................... 21

**Working with Data Prep Studio Workspaces in Monarch Swarm** .................................. 22

Accepting Inputs ..................................................................................................................... 23
  - Models ............................................................................................................................... 23
  - Projects ............................................................................................................................... 23
  - File/Database Types ........................................................................................................ 23

Known Limitations ................................................................................................................ 24

Known Differences ............................................................................................................... 25

Filters ................................................................................................................................... 25

Pivoted Tables ....................................................................................................................... 25
Introduction

Datawatch Monarch™ (Monarch) is a multi-component application that allows you to model and extract analytical assets from both structured and less-than-structured sources, such as PDFs, reports, and EDI streams, and then use the data obtained in a self-service manner on your desktop for broader analytical use. The complete features of your Monarch application depend on the license you purchased. This guide assumes that you have licenses that give you access to Monarch Classic (Classic) and Data Prep Studio (DPS). You will also need another license to gain access to Monarch Swarm. If the features you require are not included in the license you purchased and you would like to take advantage of all of Monarch's capabilities, contact Datawatch Sales.

Long-time Monarch Classic users are well aware of the application’s powerful data extraction and analytical abilities. With just a little bit of practice, any user can load both structured and unstructured data sources into Monarch Classic, create data extraction templates, filters, sort, summaries, and many other objects, and then save them to a model or project file. Models (projects) serve a dual purpose: (1) they collect all of the operations done on a report file and allow you to apply the same changes to the same file in a future Classic session without having to recreate each operation individually and (2) they perform all saved operations on other files with the same format.

DPS is a Monarch component initially intended to provide users with rapid data preparation (data prep) capabilities. As a quick data prep solution, DPS offers several powerful features, including:

- Extraction of data from any source or system, including PDF and Text files
- Conversion of unstructured, semi-structured and multi-structured data into rows and columns
- Cleaning of data with pre-built functions – no coding or advanced Excel knowledge required
- Blending of disparate data sets and easy transformation of data to enrich analytics
- Auditable change histories and clear data lineage tracking

Classic report trapping was introduced to version 15.0 of this Monarch component.

Monarch Swarm, the newest of Datawatch’s product offerings, is a server-based application that allows users across organizations and regions to explore, prepare, and distribute data seamlessly and automatically. This application presents:

- Easy to use, centralized data prep in a browser
- Governance, collaboration, and sharing
Socialization features (e.g. like, subscribe, follow)

Machine learning-powered recommendations

In version 2.0, report trapping was introduced to Monarch Swarm

As all three applications support data trapping of the same report files, models created in Monarch Classic can now be migrated to and used with DPS and Monarch Swarm. This guide describes how to migrate these models, how to use them with report files, and what the current limitations are.

Assumptions

This document assumes the following:

- The user has installed at least Monarch Complete version 15.0 and Monarch Swarm version 2.0.
- The user has experience using Monarch Classic and Data Prep Studio and can navigate to the files s/he wishes to migrate to Monarch Swarm.

Monarch Complete comes with a set of sample files that are typically installed with the application. The examples provided in this guide will use these files.

By default, sample reports are stored in C:\Users\Public\Documents\Datawatch Monarch\Reports.

Sample models are stored in C:\Users\Public\Documents\Datawatch Monarch\Models.

Saved projects are usually stored in C:\Users\Public\Documents\Datawatch Monarch\Projects.

- The user has access to a set of models and report in a local/network folder to import into DPS and Monarch Swarm
- The user has the correct credentials to upload models to the Monarch Swarm Library
Working with Monarch Classic Files in Data Prep Studio

DPS allows you to work with existing Monarch Classic models and projects. The following Monarch features are translated in DPS when you open a Monarch file:

- Data captured via all trap types
- Multi-column regions
- Formula-based calculated fields using built-in Monarch functions
- Lookup-table calculated fields
- Multiple reports
- PDF reports
- Projects that use database inputs
- External lookups
- Runtime parameter fields

When using Classic models to trap report data in DPS, the model file is first imported into the application and then the report file(s) associated with the model are selected. If the report file is loaded ahead of the model, the report file displays in the Report Design window and you will be required to construct a new model for it.

Accepted Inputs

PROJECTS

- .dprj
- .xmod

MODELS

- .dmod
- .xprj
REPORT FILES

- .dat
- .prn
- .rpt
- .txt
- .log
- .pdf (PDF engines 3.0–4.2)
- .htm

Known Limitations

The following features in Monarch models are currently not supported in DPS:

- Model files created from databases
- Summaries – Any summary definitions present in the Monarch model are ignored in DPS
- Filters – Any filter definitions present in the Monarch model are ignored in DPS
- Sorts – Any sort definitions present in the Monarch model are ignored in DPS
- User-defined functions – Fields that use user-defined functions are displayed in DPS with null values.
- External Models – External model definitions within a Monarch model are ignored when the model is imported into DPS.
- User-edited fields – Fields that use user-edited fields are displayed in DPS with null values.
- Password-protected PDFs – Monarch projects which refer to password-protected PDF(s) may or may not contain the password(s) in encrypted form. This depends on the user's choice when they saved the project. If they saved the password(s), then these projects will import cleanly and open in DPS. If they choose not to save the password(s) in the project, the project will open in DPS but no data will display.
- Project exports – Monarch has the notion of named exports, where an export is given a name and can specify not only its destination, but also the Sort and/or Filter to be applied. Exports may also be multi-way, i.e., a single export may produce multiple export files – one for each filter, for example. DPS also has the notion of named exports, but it's a simple notion without support for a specified sort or filter, and without multi-way file support. In light of these differences, at present, the conversion process does not attempt to convert named exports that may be present in the Monarch project.
- Redaction of report fields – DPS does not support Consistent Alias Replacement (CAR)-type redactions. In the case where the Monarch model specifies a CAR redaction for some field, the DPS substitutes a non-CAR redaction change that best emulates the CAR redaction specified.
Projects with inputs and models from S3, HTTPS, and FTPS (i.e., web sources that require authentication) are not supported in DPS

- Bookmarks – Any bookmarks present in the Monarch model are ignored in DPS
- Report colors – Any report colors specified in the Monarch model are ignored in DPS
- Report index – Any report index definitions present in the Monarch model are ignored in DPS
- Classic models that use PDF Engine 4.0+ may not render in the same way in DPS v15.0 and bring about differences in data extraction. Note that this limitation has been addressed and corrected in DPS v15.1

Loading Classic Models in Data Prep Studio

The binary and XML forms of Classic models can be loaded into DPS via two ways.

DRAG AND DROP

If your model file resides in a local or network folder, you can simply drag and drop this file into any of the DPS windows.

THE OPEN DATA DIALOG

Steps:

1. Launch the Open Data dialog by:
   - Clicking the application menu and then selecting Open Data or
   - Clicking Open Data from the Start page
2. In the Select Data Source to Open dialog that displays, select (for DPS v15.0) Monarch File or (for DPS v15.x) Monarch File > Monarch Model or Monarch Project > Get Data.
An **Open** dialog displays.

![Open dialog](image)

3. Use this dialog to navigate to the folder in which your model/project file resides, select this file, and then click **Open**. In this guide, we’ll load **Lesson8.dmod**. The selected model/project displays in the Prepare window.
Loading Classic Reports in Data Prep Studio

The following steps are necessary only if you opened a Monarch Model in the previous section. If you opened a Monarch Project, the table data should display automatically.

Steps:

1. Right-click on a Classic model loaded into DPS and, from the options that display, select Report Options > Add Report.
2. An **Open** dialog displays. Use this dialog to navigate to the folder in which your report file resides, select this file, and then click **Open**.

![Open dialog](image1.png)

In this guide, **Classic.prn** was selected as the report.

The selected report displays as a sub-table below the model file in the Prepare window.

![Selected report](image2.png)

If you wish to make changes to the model to capture other data from the report, you can edit it. To do so, select the model or the report file associated with it, right-click on your mouse and then select **Edit in Report Design** from the options that display.

The Report Design window displays.
Apply the necessary changes to the model and then save them by selecting **Accept**.

**Important Notes**

Changes applied to any model in DPS are only applicable to this Monarch component – these changes are not saved to the original model developed in Classic.
Further Reading

As you learn how to work with DPS, you may find the following links helpful:

- About Data Prep Studio
- Adding Data Sources to Data Prep Studio
- The Report Design Window
- Working with Monarch Files in Data Prep Studio
- Working with Report Design
- Creating Templates
Working with Monarch Classic Files in Monarch Swarm

Working with Monarch Classic files in Monarch Swarm is slightly different from that in DPS. In a typical Monarch Swarm session, users work with objects in a library. Thus, to work with Classic files, both report and model must be uploaded to the Monarch Swarm library prior to their use. Unlike in DPS, where the order of loading files is important, no specific order of file upload is necessary in Monarch Swarm.

Accepted Inputs

MODELS

- .dmod

PROJECTS

- .dprj

REPORT FILES

- .prn
- .log
- .txt
- .pdf (PDF engines 3.0–4.3)
Known Limitations

Only the report trapping data stored in Monarch Classic models are uploaded to Monarch Swarm. Thus, the following model components are NOT supported in Monarch Swarm:

- Summaries
- Bookmarks
- Report colors
- Greenbar
- Report index
- Reports with passwords
- Language options
- Decimal characters
- Summaries
- Filters
- Sorts
- User-defined functions
- External models
- User-edited fields
- Password-encrypted PDFs
- Special report-related functions (e.g., Id(), File(), Page(), etc.)
- Models created from databases

Uploading Classic Models to Monarch Swarm

Upload of Monarch Classic models to the Monarch Swarm library is accomplished via the Monarch Utility.

Monarch Utility is a Monarch component that enables users to quickly and easily perform tasks that might otherwise be very time consuming. With Monarch Utility, for example, you can:
- Copy models and projects to new locations
- Convert text/XML models or projects into binary ones
- Manage external references, authors, and descriptions in XML models or projects
- Purge audit trails in XML models or projects

Note that only binary models (i.e., .dmod) can be uploaded to Monarch Swarm. If you are using an XML model, you must first convert it into a binary file (also via the Monarch Utility) prior to upload.

The following steps describe how to upload Monarch Classic models to the Monarch Swarm library.

Steps:

1. Launch Monarch Utility by clicking **Start > All Programs > Datawatch Monarch 15 > Monarch Utility**.
   The Monarch Utility dialog displays.

2. Select the button for Upload binary models to Monarch Swarm and then click Next.

![Monarch Utility](image)

The next screen displays as follows.
3. Provide the necessary information:

- **Source**
  - Folder – The folder containing models to be uploaded to the server
  - Filename – The name(s) of the model(s) you wish to add to the Monarch Swarm library. Leave the default value of *.dmod as is if you intend to add all models in the folder to the library.

- **Monarch Swarm Credentials**
  - Server URL – The URL of the Monarch Swarm server you are connecting to
  - Username – The username of a valid Monarch Swarm user
  - Password – The password associated with the username
  - Swarm Folder – The name of a folder in Monarch Swarm in which you intend to upload Classic models. Use the Browse button to locate a folder in Monarch Swarm. You cannot proceed with upload until a folder name is provided.

You can test your connection to the server by clicking on the **Test** button located beside the Server URL field. The message **Connection succeeded** should display.

4. Click **Next** when you are finished.

The next screen reiterates your instructions for the conversion operation. Select Finish to proceed with upload if the indicated operation is correct. If you wish to make changes to the operation, select Back.
A process log showing the status of the upload operation displays afterward.

The uploaded models display in the Monarch Swarm Library as follows.

![Monarch Swarm Library](image)

Note that these models must be shared before they can be employed by other Monarch Swarm users in their work.

**Uploading Classic Report Files to Monarch Swarm**

You can add report files to the Monarch Swarm via one of several ways:

**DRAG AND DROP**

When you drag and drop the report file from a local or network folder to the Monarch Swarm library, the following window displays.
You can:

- Opt to save the report file in the Monarch Swarm library and then apply a model to it later (in case you have not uploaded an appropriate model file to the library)
- Apply an existing model to the report file (in case you had previously uploaded an appropriate model file to the library) or
- Begin report modeling (in case you wish to create a new model for the report file)

If you choose to:

- Save the report file to the Monarch Swarm library and apply a model to it later, nothing else is done to it and the file is added to the library. You can edit this file at a later time and either apply an existing model to it or define a new model for it.
- Apply an existing model to the report file, the Swarm Library Browser displays. Use this browser to locate and select the model to apply to your report. Click **Apply Selected Model** when you have made your choice. Note that the model must reside in the Monarch Swarm Library prior to its use with a report file.
The browser closes and you are brought to the **Add <Data Source Name> Data Source** page. Click **Save**.

![SWARM LIBRARY BROWSER](image)

![Add Classic Data Source](image)
The report file you uploaded is displayed in the Monarch Swarm Library. When opened in a workspace, the model you selected is applied to the report.

- Begin report modeling, the Report Design window launches. Use this window to define templates for your report.
UPLOAD A FILE VIA THE + NEW COMMAND

Besides a local/network file, your Classic reports may also reside in an Amazon S3 bucket. Assuming that you have already created a connection to this bucket, add reports to your Monarch Swarm library by using the + New > Add from Connection command.

A Connection browser displays.
Use this browser to locate and select the report you wish to bring into the Monarch Swarm Library. Select **Open** when you have made your choice.

The following window displays.

![Add Classic Data Source](image)

Follow the procedures described in the previous section (i.e., [Uploading Classic Report Files to Monarch Swarm > Drag and Drop](#)) to specify what to do next.

---

**Important Notes**

Changes applied to any model in Monarch Swarm are only applicable to this product – these changes are not saved to the original model developed in Classic.
Further Reading

As you learn how to work with DPS, you may find the following links helpful:

- Monarch Utility
- About Monarch Swarm
- Adding a Data Source to Monarch Swarm
- The Report Design Interface
- Models and Data Extraction Templates
- Creating Templates
- Adding New Connections
You can save workspaces directly from DPS to Monarch Swarm via the Application Menu > Save Workspace > Save to Monarch Swarm command.

As well, you can export data sources from DPS to Monarch Swarm. You will need to setup a connection to a Monarch Swarm server via the Application Default Settings dialog (accessed by clicking > Application Default Settings) prior to doing so.
These credentials are provided only once.

Accepted Inputs

MODELS

- .dmod
- .xmod

PROJECTS

- .dprj
- .xprj

FILE/DATABASE TYPES

Monarch Swarm accepts the following input types from DPS workspaces without requiring additional configuration:

- Delimited Text
- PDF (PDF engines 3.0–4.3)
- Report Text
- Excel (XLSX)
- Access (ACCDB)
- MySQL
- Oracle
- Postgre
- SQL
- Sybase IQ
- DB2
- HTML
- JSON
Monarch Swarm accepts the following input types from DPS workspaces with additional configuration:

- XML
- ODATA
- Hadoop Hive
- Cloudera Impala

Known Limitations

Because of the high level of integration between these applications, DPS workspaces can be opened directly in Monarch Swarm and modified as usual subject to the following limitations:

- Tables containing a Pivot with the option "Group all columns" in DPS will not open correctly in Monarch Swarm
- Grouped changes are not supported in Monarch Swarm
- Saved exports are not supported in Monarch Swarm
- Some plugin data sources in DPS may not work correctly in Monarch Swarm
- Metadata columns are not supported in Monarch Swarm
- Some file types supported in Data Prep Studio (e.g., .XPS) are not supported in Monarch Swarm.
- Summaries are not supported in Monarch Swarm
Known Differences

The current version of Monarch Swarm includes the following differences compared with DPS:

FILTERS

- When a filter of the type RANGE is created for numeric and date/time columns with null values and assuming $a$ and $b$ are start and end range values, respectively:
  - If the range is $a < x < b$, DPS hides nulls while Swarm shows them.
  - If the range is $-\infty < x < +\infty$, both DPS and Swarm show nulls.
  - If the range is $-\infty < x < b$, DPS hides nulls while Swarm shows them.
  - If the range is $a < x < +\infty$, DPS hides nulls while Swarm shows them.
- When filters containing null values are imported from DPS, Swarm does not show these null values.

PIVOTED TABLES

When a pivot table is created and there are null values in a column used for aggregation with the Count operation, DPS shows these values as null but Monarch Swarm shows them as zero.

GROUPED TABLES

When a grouped table is created and there are null values in a column used for aggregation with the Count operation, DPS shows these values as null but Monarch Swarm shows them as zero.

XML DATA SOURCES

The order of columns of an XML data source may display differently between DPS and Monarch Swarm.

FORMATTED COLUMNS

Pre-defined and custom-formatted numeric columns and custom-formatted date/time columns may display differently when a workspace in DPS is saved to Monarch Swarm.
These differences are discussed more completely in the following help topics:

- Differences in Pre-defined Numeric Columns Between Data Prep Studio and Monarch Swarm
- Differences in Custom-Formatted Numeric Columns Between Data Prep Studio and Monarch Swarm
- Differences in Custom-Formatted Date/Time Columns Between Data Prep Studio and Monarch Swarm

DATA TYPE CONVERSION

The results obtained when converting the data types of columns in input sources used in workspaces in DPS may not be similar to the results obtained when these columns are converted in Monarch Swarm. For example, a text field containing a date format may be easily converted into a date/time field in DPS but not in Monarch Swarm. As of this release, Monarch Swarm does not have the same default input local settings as DPS and no conversion option is yet available for input sources in the application. To work around this issue in Monarch Swarm, extract + conversion operations or other functions (e.g., CTOD) may be necessary.

Further Reading

As you learn how to work with Monarch Swarm, you may find the following links helpful:

- About Monarch Swarm
- Known Limitations
- The Monarch Swarm Library
- Working with Workspaces
- About Data Sources
Product Support

If you have any questions about the Datawatch products, you may receive help by:

- Logging in and filling out the form via the Datawatch Support Page (you will need to have access, or you can register first). When filling out the form:
  - Be as specific as possible and provide all of the requested information. Note: Fields preceded by an asterisk are required fields.
  - Click the Submit Form button to complete your request for support.

  Our support staff will answer your question within 1 - 2 business days.

- Calling the Datawatch Support at the numbers provided below. Provide as much information as possible, including:
  - Product name and version number
  - Operating system and version number
  - Exact error messages (where applicable)
  - A description of the problem, including the steps necessary to reproduce it, and how you attempted to solve it
  - Your contact information

  We’ll answer your call in the order we receive it. Here’s what you can expect:
  - If all support specialists are engaged with other customers, you will have the option to continue holding or to leave a message.
  - The specifics of your call are logged into our call tracking system and queued for the appropriate technical support specialist.
  - We will return your call as soon as a support specialist becomes available.
  - Faxed requests are collected periodically throughout the day and then assigned to available support specialists.
Contact Information

- To contact the Datawatch Support Center via e-mail:
  Write to us at: support@datawatch.com

- To contact the Datawatch Support Center via phone:
  
  **US and Canada**
  - Hours: Monday – Friday
  - 8:30am – 6:00pm Eastern (EST/EDT)
  - Phone: +1 800.988.4739
  - Phone: +1 978.441.2200

  **Europe, MidEast, and Africa**
  - Hours: Monday – Friday
  - 8:30am – 6:00pm London (GMT/BST)
  - Phone: +44 (20) 812 32995
  - Phone: +49 (0) 89 8890 5709

  **Australia and the Asia-Pacific**
  - Hours: Monday – Friday
  - 9:00am – 5:00pm Sydney (GMT+10)
  - Phone: +61 2 8003 7488
  - Phone: +65 6513 3398

Sales-Related Inquiries

For sales-related inquiries, you may email at sales@datawatch.com or contact Datawatch headquarters at +1 987 441 2200.